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Tutorial: Delineación de Cuencas Fluviales     

Utilizando HydroSHEDS 

1. Cree una carpeta/directorio operativo en su computadora para mantener los 

datos ordenados. Al directorio póngale el nombre de “SFBasin” (Estamos 

utilizando este nombre porque estamos delineando la cuenca del río San 

Francisco en el Brasil.) 

2. Cree subcarpetas/directorios en “SFBasin” con nombres explícitos como 

“SABasins”, “DEM”, “DrainageDirection”, “HydroBASINS”, and “RiverNetwork” 

3. Convierta la longitud y latitud de la ubicación de nuestro estudio como un archivo 

de punto georreferenciado. Long se refiere a Longitud y Lat se refiere a Latitud. 

En este ejercicio vamos a utilizar la ubicación Long/Lat para Barra, Brasil (-

43.14117, -11.089223) 

4. En Apache OpenOffice (o Microsoft Office), cree una nueva hoja de cálculo e 

ingrese la siguiente ubicación Long/Lat para Barra, Brasil como en el ejemplo 

(Apache OpenOffice es un conjunto de programas de fuente abierta. Está 

disponible en varios idiomas y funciona en la mayoría de los sistemas 

operativos.) 

 

 

 

5. Guarde la hoja de cálculo en formato CSV y llámela “BarraBrazil.csv” en el 

directorio, “SFBasin” 

6. Abra la aplicación QGIS  
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(QGIS es un sistema de información geográfica (GIS por sus siglas en inglés) 

gratuito y de fuente abierta. Esta demostración utiliza QGISv3.8 [Zanzibar]) 

7. Guarde su proyecto de QGIS como “SFBasin” en la carpeta operativa  

Project —> Save As —> Desktop —> SFBasin —> SFBasin.qgz 

8. Haga clic en el botón Open Data Source Manager en la barra de herramientas 

Data Source. También puede utilizar el atajo Ctrl + L  
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9. Haga clic en “Delimited Text” en la columna a mano izquierda en la 

ventana del Data Source Manager. Haga clic en la elipse a la derecha de “File 

name” y seleccione el archivo CSV que guardó en ApacheOpenOffice 

(“BarraBrazil.csv”). Bajo “Geometry Definition”, especifique el campo X como el 

campo Long de nuestro archivo CSV y el campo Y como el campo Lat del 

archivo CSV e ingrese el the Coordinate Reference System (CRS): World 

Geodetic System 84 (WGS 84; EPSG:4326) 

10. Haga clic en Add. Ahora debería tener una ubicación puntual importada y 

visualizada en QGIS 

a. Haga clic con el botón derecho en el archivo importado y cámbiele el 

nombre de la capa a “BarraBrazil” 
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11. Agregue un mapa de base al proyecto: Web —> QuickMapServices —> 

[Basemap] 

a. El plugin QuickMapServices es la manera más fácil de agregar mapas de 

base en QGIS. Si no tiene el plugin instalado, siga estos pasos: 

b. En el menú de barra vaya a Plugins —> Manage and Install Plugins... 

c. En la ventana de Plugins, busque QuickMapServices y haga clic en el 

botón Install 

d. Después de instalar encontrará el icono de QuickMapServices en la barra 

de herramientas del navegador Web 

e. Si no está visualizada la barra de herramientas del navegador, en el menú 

de barra haga clic en View → Toolbars → Web Toolbar 
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f. De modo alternativo, puede acceder a QuickMapServices bajo Web —> 

QuickMapServices —> [Basemap] 
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g. Para una lista completa de opciones para mapas de base, haga clic en 

QuickMapServices —> Settings —> More Services —> Get contributed 

pack. Vaya a la pestaña de Visibility (QuickMapServices —> Settings —> 

Visibility) y active/desactive los mapas de base que desee visualizar 

utilizando el menú) 

12. Después de agregar un mapa de base, cambie el Coordinate Reference System 

(CRS) del proyecto haciendo clic en el CRS en la barra Status en la parte inferior 

derecha del mapa 

 

 

13. Cambie el CRS a EPSG:4326. Notará que después de cambiar el CRS, las 

coordenadas al fondo del mapa estarán en Lat/Long. (por ejemplo, -44.26,-

12.37) 

14. Ahora utilice un navegador de internet para abrir la página en línea de 

HydroSHEDS: https://www.hydrosheds.org/ 

15. Dese tiempo para explorar la página y aprender cómo se deriva cada conjunto 

de datos 

16. Haga clic en el botón Download en la parte superior derecha de la página 

17. Seleccione Basin outlines 15sec resolution para South America: 

sa_bas_15s_beta.zip y haga clic en “Download Selected Files” e ingrese su 

correo para realizar la solicitud 
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18. Cuando termine de descargar, descomprima (unzip) la carpeta y póngala en el 

subdirectorio “SABasins” que creó en el paso 2. “SABasins” significa “South 

America river basins” (cuencas fluviales sudamericanas) 

 

19. Agregue el shapefile de cuencas sudamericanas a su proyecto 

(“sa_bas_15s_beta.shp”) 

20. Arrastre la capa “BarraBrazil” y colóquela en primer lugar en el panel Layers. 

Vemos que Barra, Brasil está ubicada dentro de la cuenca del río San Francisco. 

Para delinear la cuenca del río vamos a utilizar la herramienta Select by 

Location” bajo Vector —> Research Tools.  
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21. Exporte la cuenca fluvial seleccionada como un archivo de formato shapefile: 

haga clic con el botón derecho en la capa sa_bas_15s_beta —> Export —> 

Save Selected Feature As… —> (Guarde el archivo como “SFBasin1” en su 

carpeta operativa) y agréguela a su mapa 
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22. Remueva “sa_bas_15s_beta” del panel Layers 

23. Ahora debería tener un mapa de base para la cuenca del San Francisco y una 

capa puntual mostrando Barra, Brasil en CRS: World Geodetic System 1984 

(WGS84, EPSG:4326) 

24. Vuelva a la página de descargas de HydroSHEDS: 

https://www.hydrosheds.org/downloads 

25. Seleccione HydroBASINS → Customized (With Lakes) → South America → 

hybas_lake_sa_lev01-06_v1c.zip 
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26. Haga clic en “Download Selected Files” e ingrese su correo para realizar el 

pedido 

27. Descomprima el archivo descargado y muévalo al subdirectorio “HydroBASINS” 

que creamos en el paso 2  

28. Agregue las siguientes subcuencas fluviales a su mapa 

a. Add Vector Layer… 

b. hybas_lake_sa_lev04_v1c 

c. hybas_lake_sa_lev05_v1c 

d. hybas_lake_sa_lev06_v1c 

29. Recorte (clip) cada archivo de subcuenca al archivo “SFBasin1”  
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30. Como “Input layer” agregue “hybas_lake_sa_lev04_v1c [EPSG:4326]” 

31. Como Overlay agregue “SFBasin1 [EPSG:4326]” 

32. Bajo Clipped haga clic en la elipse a la derecha y seleccione “Save to File”  

a. Desktop → SFBasin → hybas_lake_sa_lev04.shp → haga clic en “Run” 

 

 

 

33. Cámbiele el nombre al nuevo archivo en el panel Layers 
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a. Haga clic con el botón derecho en el archivo recién “clipeado” → Rename 

Layer → hybas_lake_sa_lev04 

34. Remueva la capa “hybas_lake_sa_lev04_v1c” del panel Layers 

35. Repita los pasos 31 al 35 con los archivos  

a. “hybas_lake_sa_lev05_v1c [EPSG:4326]” 

b. “hybas_lake_sa_lev06_v1c [EPSG:4326]” 

36. Guarde su proyecto de QGIS  

37. Ahora debería tener un proyecto con capas como el que se muestra aquí 

 

 

38. Para más información sobre cómo HydroSHEDS delinea subcuencas refiérase a 

la siguiente página: https://www.hydrosheds.org/page/hydrobasins 

39. Antes de descargar más datos de HydroSHEDS, necesitamos saber la extensión 

de la cuenca del río San Francisco. Haga clic con el botón derecho en la capa 

SFBasin1 y seleccione “Properties...”  

a. Haga clic en “Information” en la parte izquierda de la ventana 

b. Ahora podrá ver metadatos para el archivo, incluso Name (nombre), Path 

(ruta), Source (fuente), CRS, Unit (unidad) etc. Nos interesa Extent: -

47.6...,-20.9… | -36.3…, -7.2... 

c. El primer conjunto de coordenadas corresponde a la extensión inferior 

izquierda (sudoeste) 
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d. El segundo conjunto de coordenadas corresponde con la extensión 

superior derecha (noreste)  

e. La extensión informa cuáles datos hay que descargar de HydroSHEDS  

40. Vuelva a la página de descargas de HydroSHEDS: 

https://www.hydrosheds.org/downloads 

41. Seleccione Drainage directions (GRID and BIL format) → Flow direction 3 sec 

resolution GRID → South America (5x5 tiles) → seleccione los 9 siguientes 

archivos  

a. s10w040_dir_grid.zip 

b. s10w045_dir_grid.zip 

c. s15w040_dir_grid.zip 

d. s15w045_dir_grid.zip 

e. s15w050_dir_grid.zip 

f. s20w045_dir_grid.zip 

g. s20w050_dir_grid.zip 

h. s25w045_dir_grid.zip 

i. s25w050_dir_grid.zip 

42. Haga clic en “Download Selected Files” e ingrese su correo para realizar el 

pedido 

43. Descomprima los archivos descargados y colóquelos en la subcarpeta 

“DrainageDirection” que creamos en el paso 2 

44. Agregue archivos ráster de dirección del desagüe de cada carpeta descargada: 

a. Add Raster Layer… → Desktop → SFBasin → DrainageDirection → 

s10w040_dir → prj.adf → haga clic en “Open” → haga clic en “Add” 

b. Repita estos pasos para los archivos de ráster direccionales 

subsiguientes 

45. Combine los archivos de dirección de desagüe en un solo archivo: 

a. Raster → Miscellaneous → Merge 
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b. Como capas de entrada (Input), seleccione los 9 archivos ráster de 

dirección del desagüe → haga clic en OK 

c. Para tipos de datos de salida (Output data type) seleccione “Byte” de la 

lista desplegable 

d. Bajo Merged haga clic en la elipse a la derecha → Save to File… → 

navegue a la carpeta operativa (“SFBasin”) y guarde el archivo como 

“merged.tif”  

e. Haga clic en el menú desplegable y seleccione los archivos TIF (*.tif) y 

haga clic en Save 

f. Haga clic en Run 
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46. Recorte el archivo de desagües combinados por el archivo vector SFBasin1  
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47. Clip Raster by Mask Layer 

a. Input layer → merged [EPSG: 4326] 

b. Mask layer → SFBasin1 [EPSG:4326] 

c. Source CRS → Project CRS: EPSG 4326 - WGS 84 

d. Target CRS → Project CRS: EPSG 4326 - WGS 84 

e. Assign a specified no data value… → -999 

f. Des-señale “Match the extent of the clipped raster to the extent of the 

mask layer” 

g. Output data type → Byte 

h. Clipped (mask) → Save to File… → Desktop → SFBasin → 

“DrainageDirection1.tif” 

i. Haga clic en Run 
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48. Cámbiele el nombre a la capa recortada en el panel Layers a 

“DrainageDirection1” 

49. Simbolice la capa de flujo de drenaje siguiendo estos pasos: 

a. Haga clic con el botón derecho en la capa “DrainageDirection1”  

b. Haga clic en “Properties” 

c. Haga clic en “Symbology” en la columna izquierda de la ventana Layer 

Properties  

d. Render type → Singleband pseudocolor 
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e. Color ramp → Blues 

f. Mode → Quantile 

g. Classes → 8 

h. Deje los demás parámetros con sus valores preprogramados y haga clic 

en OK 
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50. Los mapas de dirección del desagüe distribuidos con HydroSHEDS 

definen la dirección del flujo de cada celda a la celda vecina con la mayor 

pendiente cuesta abajo. Los valores de la dirección del flujo varían del 1 al 128. 

Todas las celdas de salida final al océano están marcadas con un valor de 0. 

Todas las celdas que marquen el punto más bajo de una cuenca endorreica 

(depresión mediterránea) se marcan con un valor de -1. Los valores para la 

dirección del flujo siguen en convenio adoptado por el ESRI: 

 

 

 

51. Remueva las nueve capas de dirección de desagüe del panel Layers  

52. Remueva la capa combinada del panel Layers  

53. Guarde su proyecto de QGIS  

54. Ahora debería tener un proyecto con una capa delineada para la cuenca del río 

San Francisco, 3 capas de subcuencas, una capa de dirección de flujo 

simbolizada, una capa para Barra, Brasil y un mapa de base 

 

http://arset.gsfc.nasa.gov/
http://arset.gsfc.nasa.gov/
http://arset.gsfc.nasa.gov/
http://arset.gsfc.nasa.gov/
http://arset.gsfc.nasa.gov/
http://arset.gsfc.nasa.gov/
http://arset.gsfc.nasa.gov/


 
Webinar Nivel Introductorio: Delineación de Cuencas Fluviales  

en Base a Datos de Elevación Digitales de la NASA 
26 de noviembre de 2019 

 

http://arset.gsfc.nasa.gov/   22  

 

 

55. Para este paso, Ud. ha descargado y procesado datos de HydroSHEDS en base 

a una ubicación geográfica. Ha delineado una cuenca fluvial y algunas 

subcuencas incluyendo la dirección del flujo de cada celda a la celda vecina de 

mayor pendiente cuesta abajo. Estos pasos se pueden seguir para cualquier 

otra ubicación geográfica 

Los siguientes pasos son opcionales para este webinar pero altamente 

recomendados  
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56. Descargue y procese capas de datos de HydroRIVERS. HydroRIVERS 

ofrece una cobertura mundial del alcance consistente de los ríos: 

https://www.hydrosheds.org/images/inpages/HydroRIVERS_TechDoc_v10.pdf 

57. Vaya a la página de HydroRIVERS: 

https://www.hydrosheds.org/page/hydrorivers 

58. Desplácese hacia abajo a Shapefiles y haga clic en “Download” al lado de 

“South America” 

 

    

 

59. Descargue y descomprima el contenido de la carpeta en el directorio 

“RiverNetwork” que creó en el paso 2 

60. Agregue el archivo “HydroRIVERS_v10_sa.shp” a su proyecto 
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61. Recorte el archivo HydroRIVERS por la capa SFBasin1 y guarde el nuevo 

archivo en su carpeta operativa como “SF_Rivers”. Haga clic en Run 

 

  

 

 

 

62. Cámbiele el nombre a la capa recortada a “SF_Rivers” en el panel Layers  

63. Simbolice la capa SF_Rivers con un tono azul 

64. Remueva HydroRIVERS_v10_sa del panel Layers  

65. Guarde su proyecto de QGIS  
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66. Vuelva a la página de descargas de HydroSHEDS: 

https://www.hydrosheds.org/downloads 

67. Seleccione Void-filled elevation (GRID and BIL format) → Elevation 3sec 

resolution GRID → South America (5x5 tiles) → seleccione los nueve siguientes 

archivos 

a. s10w040_dir_grid.zip 

b. s10w045_dir_grid.zip 

c. s15w040_dir_grid.zip 

d. s15w045_dir_grid.zip 

e. s15w050_dir_grid.zip 

f. s20w045_dir_grid.zip 

g. s20w050_dir_grid.zip 

h. S25w045_dir_grid.zip 

i. s25w050_dir_grid.zip 

68. Haga clic en “Download Selected Files” e ingrese su correo para realizar el 

pedido 

69. Descomprima los archivos descargados y colóquelos en el subdirectorio “DEM” 

que creamos en el paso 2 

70. Agregue los archivos de elevación ráster de cada carpeta descargada: 

a. Add Raster Layer… → Desktop → SFBasin → DEM → s10w040_dem → 

prj.adf → haga clic en “Open” → haga clic en “Add” 

b. Repita estos pasos para los subsiguientes archivos de elevación ráster 

71. Combine los 9 archivos de elevación en uno solo file: 

a. Raster → Miscellaneous → Merge 

b. Como Input layers (entrada), seleccione los 9 archivos de elevación ráster 

→ haga clic en OK 

c. Como Output data type (salida) seleccione “Int16” de la lista desplegable 

d. Bajo Merged haga clic en la elipse a la derecha → Save to File… → 

navegue a su carpeta operativa (“SFBasin”) y guarde el archivo como 

“merged1.tif”  

e. Haga clic en el menú desplegable y seleccione los archivos TIF (*.tif) y 

haga clic en Save 

f. Haga clic en Run 
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72. Recorte la capa combinada por la capa SFBasin1  

a. Raster → Extraction → Clip Raster by Mask Layer… 

b. Input layer → Merged1 

c. Mask layer → SFBasin1 

d. Source CRS → Project CRS: EPSG: 4326 - WGS84 

e. Target CRS → Project CRS: EPSG: 4326 - WGS84 

f. Assign a specified no data value… → -999 

g. Des-señale donde dice “Match the extent of the clipped raster to the 

extent of the mask layer” 

h. Output data type → Int16 
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i. Clipped (mask) → Save to File… → Desktop → SFBasin → “SF_DEM.tif” 

j. Haga clic en Run 
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73. Cámbiele el nombre al archivo de elevación recortado a “SF_DEM” 
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74. Remueva las 9 capas de elevación y la capa combinada 

75. Cambie la simbología de la capa SF_DEM  

a. Haga clic con el botón derecho en la capa SF_DEM  

b. Haga clic en Symbology en la columna izquierda 

c. Render type → Singleband pseudocolor 

d. Haga clic en la flecha hacia abajo en el lado derecho de la rampa de color   

 

 

 

e. Haga clic en Create New Color Ramp… 

f. Seleccione Catalog: cpt-city de la lista desplegable. Haga clic en OK 

g. En el panel Name → Topography → elevation (palette) 

h. Haga clic en OK  

 

76. Debería tener un mapa parecido al que sigue 
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77. Para mejorar la presentación de los datos de elevación, combinaremos el DEM 

con una capa de sombras de colinas (hillshade) mediante los siguientes pasos  

a. Haga clic con el botón derecho en la capa SF_DEM → Duplicate Layer 

i. Esto crea una capa llamada “SF_DEM copy” en el panel Layers  

b. Arrastre “SF_DEM copy” para que esté antes de “SF_DEM” en el panel 

Layers  

c. Menu Bar → View → Panels → Layer Styling (puede presionar F7 como 

atajo) 

d. Seleccione el icono de Symbology en la parte izquierda de la ventana the 

Layer Styling  

e. Seleccione “SF_DEM copy” de la lista desplegable de capas 

f. Seleccione Hillshade de la segunda lista desplegable 

g. Layer Rendering → Blending mode → seleccione “Multiply” del menú 

desplegable 

h. Haga clic en Apply 

78. Guarde su proyecto de QGIS  
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79. Para la cuenca del río San Francisco, ahora ha delineado subcuencas, ha 

delineado la dirección del flujo, una red fluvial y un DEM mejorado. Esta misma 

metodología se puede aplicar a cualquier cuenca fluvial en el planeta y sirve 

para análisis científico adicional y visualización de datos.  
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